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This Tutorial introduces you to Oracle WebCenter Portal: Framework, a key component of Oracle WebCenter Portal that enables you to build your own WebCenter Portal: Framework Applications. As you work through this Tutorial, you'll become familiar with Oracle JDeveloper and the components that have been added to support the new Oracle WebCenter Portal: Framework functionality. When you're ready to begin building your own application, you can move on to the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal for assistance.
| Note: For the portable document format (PDF) version of this manual, when a URL breaks onto two lines, the full URL data is not sent to the browser when you click it. To get to the correct target of any URL included in the PDF, copy and paste the URL into your browser's address field. In the HTML version of this manual, you can click a link to directly display its target in your browser. |
This document is intended for users wishing to familiarize themselves with Oracle WebCenter Portal: Framework and learn how to develop WebCenter Portal: Framework Applications.
This Tutorial does not assume any prior knowledge of Oracle JDeveloper or Oracle WebCenter Portal. It does, however, assume that you are already somewhat familiar with the following:
The Tutorial is intended for the developer who wants to learn how to build a WebCenter Portal: Framework application. It is aimed specifically at WebCenter site developers, consultants, project managers, and site administrators who need to build and administer portal applications.
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.
Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
For more information on Oracle WebCenter Portal: Framework, see the following documents, which are available on the Oracle WebCenter Suite Documentation page on the Oracle Technology Network (OTN) at http://www.oracle.com/technology/products/webcenter/documentation.html:
For more information on Application Development Framework, see the Oracle Fusion Middleware Fusion Developer's Guide for Oracle Application Development Framework.
The following text conventions are used in this document:
| Convention | Meaning |
|---|---|
| boldface | Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary. |
| italic | Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values. |
|
| Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter. |
Welcome to Oracle WebCenter Portal: Framework! This chapter introduces you to key WebCenter Portal: Framework concepts, then explains what you will create following the steps in this Tutorial. The lessons are designed to familiarize you with different aspects of WebCenter Portal: Framework functionality, and to demonstrate enough about each feature so that you can create your own WebCenter Portal: Framework applications.
If you need additional information about a feature, you can always refer to the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal and the Oracle Fusion Middleware User's Guide for Oracle WebCenter Portal: Spaces.
The WebCenter Portal: Framework provides portal-specific features to a WebCenter Portal application. Portals allow users to view and interact with information and to customize their experience to match their exact requirements. Portals typically include features like pages, navigation, security, and customization. Portals can also include features like portlets, content management system integration, personalization, social computing services, search, analytics, and more.
WebCenter Portal: Framework augments the Oracle ADF environment by providing additional integration and runtime customization options. In essence, the framework integrates capabilities historically included in portal products, such as navigation, page hierarchies, portlets, customization, personalization, and integration, directly into the fabric of the JSF environment. This eliminates artificial barriers for the user and provides the foundation for developing context-rich applications.
You can selectively add only desired Oracle WebCenter Portal components or services to your WebCenter Portal application. For example, you might only want to add the Instant Messaging and Presence (IMP) service. In this case, you could add just that service without adding all of the other services available with Oracle WebCenter Portal.
Figure 1-1 provides an overview of the Oracle WebCenter Portal architecture, showing the major components that make up the product.
In Figure 1-1, notice Oracle WebCenter Portal: Services and Composer. You will use both of these components in conjunction with WebCenter Portal: Framework in this Tutorial.
For more information about WebCenter Portal: Framework, WebCenter Services, and Composer, refer to “Understanding Oracle WebCenter Portal" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
In this Tutorial, you will use WebCenter Portal: Framework to build a WebCenter Portal: Framework application that is customizable at runtime, empowering you and your end users to edit application pages according to personal requirements and directly leveraging Oracle Metadata Services (MDS).
Building your portal application, you will also use Composer, which is an easy, browser-based environment whose components you can simply add at design time to a page in JDeveloper. In conjunction with Metadata Services, Composer provides a runtime editing tool that enables business users to edit application pages. Changes made to a page at runtime are then saved as metadata, separate from the base application definitions. This eliminates the need to revise your application and redeploy it to the production environment.
The goal is for you to complete the lessons in the Tutorial and build your WebCenter Portal: Framework application within a period of about two hours. In so doing, you will gain valuable hands-on experience working with Oracle JDeveloper and learning some of the important, high-level concepts you need to master in order to extend your knowledge of JDeveloper and the Framework.
The Tutorial is not intended to provide you with a complete guide to all the features and capabilities available in the WebCenter Portal: Framework. However, as you build your portal as a developer at design time, you ought to become familiar with some of the key concepts and paradigms in the Framework, such as
You will create a content repository connection that is owned and deployed by your WebCenter Portal application. In this case, the connection will be to the Oracle WebCenter Content repository with access provided to the Oracle Content Server. You will set UCM as your primary connection and navigate to the UCM Content folder in the Contributions directory, where the HTML content for your application is stored. You will then retrieve this content and use it to customize portal pages by dragging and dropping the documents from the folder on to various components and rendering that content as Content Presenter task flows. This is a preferred and recommended method of working with the tools available in the Portal Framework.
By using Oracle WebCenter Portal: Services to integrate content from a content repository, you will be able to display that content in a user-friendly interface and enable users to “tag” and search the content.
Go Green Eat Fresh is a public facing website that offers restaurant customers a choice of healthy and fast foods to eat, including pastas, meat and salads. Customers can browse and select from a menu of choices on the Home page of the portal. Administrators and registered users with access can edit the content of HTML documents, such as menus, food listings and orders, at runtime. That content is stored in folders in Oracle WebCenter Content repository for easy access and can be retrieved when content pages need to be changed or modified.
In this Tutorial you play the dual role of a portal developer and a website administrator who is tasked with building the Go Green Eat Fresh portal and managing its content repository, changing and updating its content based on customer needs and demands.
These will be your assigned tasks:
Figure 1-2 shows a partial view of the WebCenter Portal: Framework Application you will create following the lessons in this Tutorial.
This Tutorial is designed for the chapters to be completed in the same sequence as they are presented. Due to dependencies, completing them in a different order may result in missing resources or even errors.
The path through this Tutorial is as follows:
To prepare for this Tutorial, you need to obtain and install the current release of Oracle JDeveloper 11g Release 1 (11.1.1.7) software on your system. You also need to verify if you have the correct Oracle WebCenter extension installed. Beyond that, you will need to copy and extract a folder with sample Tutorial files on your hard drive. This chapter explains what you need to install in order to successfully complete the lessons in the Tutorial.
In addition, you will need to create a connection to a content repository. This is a necessary and preferred way of working with a content-based portal, such as the one you will create by following the lessons in this Tutorial.
Chapter 6, "Connecting to and Managing Content Repositories" describes how you create a connection to the Oracle WebCenter Content repository. Note that you can also have portal applications that do not use content stored in a repository.
You will set up the environment for the Tutorial by following these steps:
Oracle JDeveloper provides an integrated development environment for developing WebCenter Portal applications. For information on obtaining and installing Oracle JDeveloper, see the Oracle JDeveloper page on OTN at:
http://www.oracle.com/technetwork/developer-tools/jdev/overview/index.html
Before you can develop WebCenter Portal applications, you must install the WebCenter Portal extension bundle in Oracle JDeveloper. This extension bundle is a JDeveloper add-in that provides the complete set of WebCenter Portal capabilities and features to the JDeveloper Studio Edition.
To check whether WebCenter Portal extension is installed for JDeveloper, click the File menu and select New Application. In the new window, select General - Applications. If you see WebCenter Portal - Framework Applications and WebCenter Portal - Portlet Producter Applications, then WenCenter Portal extension has been installed for JDeveloper. If they do not appear, then you must install the WebCenter Portal extension.
To install the WebCenter Portal extension bundle:
JDeveloper is now configured to create the WebCenter Portal application for this Tutorial.For more information on obtaining and installing Oracle WebCenter Framework, see the Oracle WebCenter page on OTN at:
Oracle strongly recommends that you set an environment variable for the user home directory that is referenced by JDeveloper. By setting this variable, you can avoid receiving long pathname errors that are known to occur in some circumstances.
For detailed instructions on setting the user home directory on Windows, Linux, UNIX, and Mac OS X operating systems, see the section "Setting the User Home Directory" in Oracle Fusion Middleware Installation Guide for Oracle JDeveloper.
Once you have obtained the software, ensure that you have installed Oracle JDeveloper 11g Release 1 (11.1.1.7), shown in Figure 2-1, and the Oracle WebCenter Portal extension (11.1.1).
If you are not sure whether you have the WebCenter Portal extension, you can verify this by opening Oracle JDeveloper, then About from the Help menu, then click the Extensions tab. At the top of the About dialog, you should see Oracle JDeveloper 11g Release 1 11.1.1.7.0. On the Extensions list, sort by Identifier to locate the oracle.webcenter.* components.
Figure 2-2 shows the Oracle WebCenter Portal components listed in JDeveloper.
If you do not see these components (shown in Figure 2-2), you must install the WebCenter Portal extension, as described in the following steps.
To install the WebCenter Portal extension to Oracle JDeveloper using the Update Center, see "Step 2: Install the WebCenter Extension Bundle".
For more information on obtaining and installing Oracle WebCenter Portal Framework, see the Oracle WebCenter Portal page on OTN (http://webcenter.oracle.com).
Installation of Oracle WebCenter Portal Framework reconfigures the Integrated WebLogic Server (WLS) domain in JDeveloper to include additional libraries and several prebuilt portlets. For this Tutorial, you may not need to work with the additional libraries or prebuilt built portlets. However, you do need to know how to start and stop Integrated WLS.
There are several options for starting Integrated WLS available in the Run menu in Oracle JDeveloper.
Running the service in debug mode helps in debugging the service.
There are several ways to determine if the integrated WLS is running and to stop it.
| Note: Sometimes WebLogic Server is not accessible (for example, if a user tries to restart WebLogic Server too quickly, before it has successfully shut down). In this case, you may have to manually shut down or stop the Java process. |
In working with Integrated WLS, it is important to understand the following concepts.
Integrated WebLogic Server (Integrated WLS) is a preconfigured WebLogic Server that provides a complete Java 2 Enterprise Edition (Java EE) 1.4-compliant environment. It is written entirely in Java and executes on the Java Virtual Machine (JVM) of the standard Java Development Kit (JDK). You can run WebLogic Server on the standard JDK provided with your operating system or the one provided with Oracle JDeveloper.
You can use Integrated WLS as a platform for pretesting WebCenter Portal application deployments on your local computer by establishing an application server connection to it from Oracle JDeveloper. When you run the application in Integrated WLS, it is actually deployed as if you were deploying it to a WebLogic Server instance in an application server. For more information about Integrated WLS, see Section 64.3, “Deploying a WebCenter Portal Application to a WebLogic Managed Server,” in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
| Note: You can specify the Java Virtual Machine (JVM) settings for a WebCenter Portal application running on the Integrated WLS in the
The default memory values are:
When creating or referring to the |
As you work through the lessons in this Tutorial, you'll need to include certain content -- images, skins and templates -- in your portal application. This material is contained in a ZIP file, which you can download by following these instructions.
To download the sample Tutorial files:
owcs-r11ps3-devtutsetup-254761.zip), as shown in Figure 2-4. C:\TutorialSetUp. In Chapter 4, "Creating a New Page Template with a New Portal Skin," you will extract the contents of these files and copy them step-by-step to their appropriate folders for use in building your portal application.
The UCM Content folder contains HTML content (Figure 2-5) you will need in creating your WebCenter Portal application, as you work through the lessons in this Tutorial.
To complete the lessons in this Tutorial, you will need access to a content repository, specifically one that is owned and deployed by your WebCenter Portal application. In this case, for purposes of this Tutorial, you will need to create a connection to the Oracle WebCenter Content repository, which provides access to the Content Server.
Connecting to the Oracle WebCenter Content repository is a preferred use case and best practice for creating WebCenter Portal applications, if you need to work with content-based portal, as is the case with the lessons described in this Tutorial.
Chapter 6, "Connecting to and Managing Content Repositories" discusses in detail the steps you need to follow to create a connection to Oracle WebCenter Content. It is not necessary to create this connection before starting to create and build your portal application.
For more information about creating a content repository connection, see the chapter “Managing Content Repository Connections” in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal and the section "Configuring Oracle WebCenter Content Server Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.
In this lesson, you will create a basic WebCenter Portal: Framework application. WebCenter provides an application template that provisions the new application with WebCenter Portal files and libraries – everything you need to develop and deploy a portal.
You will play the role of a portal developer assigned the task of developing the basic structure of the portal. By selecting the option to configure your application with standard portal features, you will ensure that all the necessary portal artifacts, like templates, catalogs, skins, default page, and the Resource Manger, are generated in the application. This will reduce the time required to develop your application.
As a developer, you will learn in this lesson how to work with the existing application template, and then in "Creating a New Page Template with a New Portal Skin" how to modify and change that default page template.
At the end of this lesson, the page you create will look like Figure 3-1 when you log in as Administrator and open the page in a web browser.
This lesson contains the following steps:
Before you begin the steps in this lesson, ensure you have followed the steps up to this point in the Tutorial.
Let's begin by creating a WebCenter Portal: Framework application, using the WebCenter wizard for creating new portal applications. The wizard uses an out-of-the-box Portal Application template that ensures the appropriate application components are included.
After you create your portal application, you can then configure the necessary connections to a database and content repository, as described in Chapter 6, "Connecting to and Managing Content Repositories."
To create a WebCenter Portal application:
MyPortalApplication, as shown in Figure 3-4. Click the Browse button in the Directory field to specify the directory on your system where you want your portal application to reside. my.portal.application. The Name your project dialog appears in the wizard, as shown in Figure 3-5. On the Project Name tab, in the Project Name field, note that the project is named Portal by default.
On the Project Java Settings tab, in the Default Package field (Figure 3-6), note that the project package is named my.portal.application.portal by default. A source root directory and an output directory are also specified by default.
The Configure WebCenter settings dialog appears, as shown in Figure 3-7. Ensure that the checkbox Configure the application with standard Portal features is checked.
In the wizard, Step 5 of 5 appears in the Create WebCenter Portal - Framework dialog. A second project name is created, entitled PortalWebAssets, as shown in Figure 3-8.
Oracle JDeveloper now configures and generates the base XML files, offline databases, page flows, web pages, business components, web services, binding files, and enterprise Java Beans available for you to build and deploy your WebCenter Portal application, as shown in the MyPortalApplication Overview window (Figure 3-9).
Note PortalWebAssets is also a project. PortalWebAssets are intended to include static resources, like HTML and image files, in a newly created portal web assets project.
Following the steps in the Wizard, your WebCenter Portal application is now populated with a portal project, named Portal, and a static application resources project called by default PortalWebAssets. Your portal project includes features like site navigation, page hierarchies, delegated administration, security, page templates, and runtime customizing. Your portal application can consume portlets, incorporate content management services, and include WebCenter social computing services. PortalWebAssets include static application resources like HTML and image files. By separating the static resources into a separate project, you can deploy those resources to a dedicated server.
mytutorial, as shown in Figure 3-13, and click OK. Ensure that the Java EE web context root is set to mytutorial.
A Configure Default Domain dialog appears, as shown inFigure 3-14. In the Administrator ID field, enter weblogic. In the Passworld field, enter weblogic1. Note that you can change any of these values at your discretion.
Oracle JDeveloper now builds the application out of the box and displays the default portal page Home in a web browser, as shown in Figure 3-15.
Initially, this portal displays a single page, rendered as Home. The Home page is based on the seeded Globe page template (discussed in the next section), which provides all the initial functionality of the portal, including a banner, a login form with User Name and Password fields, and a navigation menu with a single link element -- Home -- displayed on the web page.
In the upper right corner of the Home page, in the User Name field (Figure 3-16), you can log into the Home page. Enter weblogic as the User Name. (Note that the weblogic user is seeded in the integrated WebLogic Server.) In the Password field, enter weblogic1.
Figure 3-17 shows the portal Home page with Administrator privileges enabled after successfully logging in.
Note that Administrator privileges are now enabled because you can see the Administration link in the upper right corner of the web browser. This means the user, specified here as weblogic, has administration privileges for the portal.
For more information on creating an application based on the WebCenter Portal Application template, see “Preparing Your Development Environment” in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
When you create a portal, you will base its look and feel on a page template. Page templates enable you to maintain a consistent look and feel across all the pages in your portal, and typically determine the artifacts, like banners, footers and navigation bars, that surround the main content of the page.
Using JDeveloper, you can create and publish page templates. In addition, you can also modify them to meet specific design or runtime requirements in your portal application.
By selecting the Configure the application with standard Portal features option, as shown in Figure 3-7, "Configure WebCenter Settings - Step 4 of 5", two seeded, out-of-the-box templates are added by default to your portal application: pageTemplate_globe.jspx (shown in Figure 3-19) and pageTemplate_swooshy.jspx (Figure 3-20).
Both templates offer essentially the same functionality but with a different set of graphics.
To view the pageTemplate_globe.jspx template:
pagetemplates folder in your portal project. pageTemplate_globe.jspx file, as shown in Figure 3-18. Ensure that you select the Design tab in the lower left corner.
Figure 3-19 shows the pageTemplate_globe.jspx page template with each of its page features and artifacts (enumerated below) called out with their corresponding numbers in the illustration.
Figure 3-20 shows the pageTemplate_swooshy.jspx page template, but without each of its page features and artifacts enumerated.
Using JDeveloper, you can modify and edit this default page template to meet your particular requirements. You can also create and build your own page template, as we discover in the next lesson in this Tutorial, ensuring that it has a common navigation bar, footer, and banner, then leave it up to your content contributors to populate the portal with content at runtime.
Following the steps outlined in this Tutorial, you have created a new portal application using Oracle JDeveloper.
In the next lesson, you will learn how to modify and edit an existing page template, with the goal of customizing its behavior to meet the particular needs of your end users. By completing that task, you will create a new page template in your portal application, further customizing its look and feel, and then set that template as an application resource.
In this lesson, working as a developer at design time, you will enhance the WebCenter portal application you constructed in the previous lesson and learn how to create a new JSF page template and register that template as a portal resource.
To achieve this goal, you will need to create a new page template, then extract the setup files provided with this Tutorial on your hard drive. The setup contains a batch of files with graphic images, skins and templates. You will then replace the new page template created by you in the application with the page template provided in the setup.
In the last step, you will register the new template and customize the site template, adding new images and a new skin to your portal application. When you run the application in a web browser, you will see a new home page with a new skin applied at runtime.
This lesson contains the following steps:
| Note: Before you begin the steps in this lesson, ensure you have followed the steps up to this point in the Tutorial. |
To extend the capabilities of our portal application, we need to create a new page template.
Note that in this step, we won't build a new JSF page template from scratch. But rather, we'll rely on a pre-configured, ready-made template which, following the steps in this lesson, you will extract into your application. To ensure that the template artifacts are correctly registered inside the application, we will create an empty template and then replace it with the one provided in the Tutorial Setup file.
You can use page templates to control the layout of your portal. A page template is a JSPX file that specifies the look and feel of your portal's pages. The template defines header, footer, content, and navigation regions within the page. You can apply the template to any number of pages, resulting in a consistent look and feel.
For more information about page templates, see “Understanding Pages, Page Templates, and the Portal Page Hierarchy” in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
To create a new page template in our portal application:
/oracle/webcenter/portalapp/pagetemplates) and right-click the folder and choose New. A New Gallery dialog appears, as shown in Figure 4-1.
myTemplate.jspx. The file name identifies the page template in the Application Navigator.
MyTemplate. pagetemplates folder, select myTemplate.jspx, then right-click the Go to Page Definition menu item, as shown in Figure 4-3. | Tip: A page definition file is an The |
myTemplatePageDef.xml file now resides in the Application Sources sub folder pagetemplates, as shown in Figure 4-5. By associating a page definition with the page template, you will be able to include model objects, such as task flows and portlets, in the page template. Users can also switch to a different page template at runtime, if they choose.
It's important to note that within your portal application, page templates must either all have associated page definitions or none have associated page definitions. The reason for this is that if you have a combination of page templates with and without associated page definitions, users won't be able to switch templates at runtime.
For more information about templates and skins, see the chapter “Designing the Look and Feel of Your Portal” in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
Now you want to extract the provided Tutorial setup files from a folder (owcs-r11ps3-devtutsetup-254761.zip) that resides on your local hard drive and then move those files to the appropriate folders in the WebCenter Portal application.
If you have not yet downloaded these setup files, as described in "Step 6: Download the Sample Tutorial Files" in Chapter 2, then do so now. You can download the files from your web browser. The files are available at this URL address:
http://www.oracle.com/technetwork/middleware/webcenter/owcs-r11ps3-devtutsetup-254761.zip
To extract the setup files and place them in the correct location in your newly created application in JDeveloper:
owcs-r11ps3-devtutsetup-254761.zip file onto your hard drive in the directory of your choosing, and then proceed to unzip the files and extract their contents, as described in the following steps. C:\...\USERS\Desktop\TutorialSetup\owcs-r11ps3-devtutsetup-254761.zip\. Four folders reside in that directory: images, skins, templates, and UCM Content, as shown in Figure 4-6. Note that the UCM Content folder contains content that you need to upload to a UCM content repository, as discussed in Step 6: Download the Sample Tutorial Files.
images folder (Figure 4-7) and move those contents to the MyApplication/Portal/public_html/images folder in your portal application. skins folder (Figure 4-8), moving those contents to the MyPortalApplication/Portal/public_html/oracle/webcenter/portalapp/skins/ folder in your portal application. Note that the extracted skin is a Cascading Style Sheet (CSS) document. templates folder (Figure 4-9), moving those contents to two separate locations, in this case moving the myTemplate.jspx template to the MyPortalApplication/Portal/public_html/oracle/webcenter/portalapp/pagetemplates/ folder and the myTemplatePageDef.xml to the MyPortalApplication/Portal/adfmsrc/oracle/webcenter/portalapp/pagetemplates folder. The myTemplatePageDef.xml file now resides in the pagetemplates folder.
myTemplate.jspx and tutorial-skin.css, appear in their respective folders, as shown in Figure 4-11. Application Sources folders and navigate to the webcenter folder in your project directory. In this next sequence of steps, you will create a portal resource at design time to customize both the site template and apply the newly provided tutorial skin.
webcenter folder in your portal project and navigate to the pagetemplates folder in the directory. myTemplate.jspx file and right-click the file. My Site Template (Figure 4-13) and click OK. skins folder and open it. Select the tutorial-skin file and right-click the Create Portal Resource menu item, as performed in the previous step. Tutorial Skin, and in the Skin Family field, enter mycustomskin, as shown in Figure 4-14. weblogic (which enables you to have administrative privileges) and enter weblogic1 as your password. Note that as discussed in Chapter 3, "Creating a WebCenter Portal Application," you must log in as a user with administrative privileges. In the Tutorial, the user “weblogic” has administrative privileges.
My Site Template is hidden. With that row selected, from the Edit menu, choose Show to change its state to Available. A green checkmark and the word "Available" appear next to it now, and it is available for use in the application. Tutorial Skin selected, from the Edit menu, choose Show to change its state to Available. My Site Template as the default page template, as shown in Figure 4-16. Tutorial Skin from the list. Now set the default portal skin to Tutorial Skin (Figure 4-17). In this lesson, you have learned how to enhance your portal application by creating a new page template, setting that template as a portal resource and applying a new skin (extracted from the Tutorial Setup files and copied into the skins folder in your project) to your portal to change its look and feel at runtime.
In the next lesson, you move ahead to further customize your application portal by changing the default settings of your template at design time in JDeveloper.
In the previous lesson, you changed the default template in your portal application to myTemplate and proceeded to change the default skin to the tutorial skin provided in the folder on your hard drive whose contents you extracted. These changes then appeared in your web browser as a new template and a new skin when you built and ran your application in JDeveloper.
Now in this lesson, you will move ahead to change the default settings for both your template and skin at design time in JDeveloper. When you launch your portal application again in a web browser, these changes will show the new default settings with changed preferences, as well as the new template and skin. In so doing, you'll learn how to change the look and feel of your portal application at design time and how to apply skins to your portal.
A skin is essentially a global style sheet (based on the Cascading Style Sheet specification [CSS]) that you can apply to your entire application. Once you do that, every layout component automatically uses the styles assigned by the skin. You cannot edit that skin at runtime or post-deployment, however.
Skins are important because they enable you to define the appearance of your application and achieve some degree of consistency across multiple pages, so that you can more effectively communicate your company's preferred look and feel.
This lesson contains the following steps:
Before you begin the steps in this lesson, ensure you have followed the steps up to this point in the Tutorial.
When you create a WebCenter Portal Application using the WebCenter Application template, a skin is included by default. In this Tutorial, you've extracted a custom skin provided for you, which you've then applied in place of the default skin. Now you need to change the default settings for both the skin and the provided template by changing their preference entries.
To change the default preferences of your portal application at design time, you will need to directly edit the adf-config.xml file in your project. The steps to accomplish this task are described in this section, as follows.
To change the default settings for the skin and template:
adf-config.xml. To locate this file in JDeveloper, open the Application Resources part of the Application Navigator. Then, open the Descriptors folder and the ADF META-INF folder, as shown in Figure 5-1.
adf-config.xml file and open it. The file appears in the Overview tab, as shown in Figure 5-2. adf-config.xml file, enter the word preferences. Navigate in the XML schema to this code (Example 5-1): value attribute to myTemplate.jspx and change the desc attribute to "My Site Template", as shown in Example 5-2. desc attribute "Default Portal Skin" and the value attribute "portal", shown in Example 5-3. Select "portal" and change it to "mycustomskin". adf-config.xml file, note that the value attribute is now updated as "mycustomskin", as shown in Example 5-4. desc attribute from "Default Portal Skin" to "Tutorial Skin", shown in Example 5-5. adf-config.xml file. Home page appears in a web browser, log in as User weblogic and Password as weblogic1 to log in and enable Administrator privileges. Tutorial Skin, when checked, will be available to the application (Figure 5-3). Since you are still developing your application (and have not yet deployed it), you can continue to switch back and forth between the runtime view and design time in Oracle JDeveloper to modify the look and feel.
For more information about changing default templates and applying different skins at design time, see Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
The steps that follow describe how you can change the default page template at runtime. You accomplish this by logging in as a user with administrative privileges and clicking the Administration link in the web browser to access the Administration Console. Once in the Administration Console, you will select the Resources tab that lets you work with portal-specific features at runtime, like page templates.
The values you enter in the Administration Console, modifying or changing page templates, will be lost the next time you choose Run from JDeveloper, however.
| Note: You can also change the default page template by modifying the |
To change the default page template from Globe to Swooshy:
Home portal page in the web browser, log in as weblogic and weblogic1 as your password. Note that you must log in as a user with administrative privileges. In the Tutorial, the user "weblogic" has administrative privileges.
Globe PageTemplate and the Swooshy PageTemplate appear, as shown in Figure 5-6, with the Globe PageTemplate field highlighted. Note that both templates are marked as available, so you can apply them. Default Page Template is specified as the Globe PageTemplate (Figure 5-7). Default Page Template and set it to the Swooshy PageTemplate, as shown in Figure 5-8. In this lesson, you've learned how to change the default settings for both your template and skin at design time in JDeveloper by changing their preferences and updating portal resources. With those changes in effect, your portal application will have a different look and feel.
You also learned how to change the default page template at runtime from Globe to Swooshy by accessing the Administration Console and modifying preferences.
In this lesson, you will create a content repository connection that is owned and deployed by your WebCenter Portal application. In this case, the connection will be to the Oracle WebCenter Content repository with access provided to the Oracle WebCenter Portal's Content Service for Oracle WebCenter Content. You will set Oracle WebCenter Content as your primary connection and navigate to the Contributions directory, where HTML content files for your application, like About Us, Contact Us, Home and Menu, are stored in content sub folders.
You will then work with these files and the Documents - Content Presenter service to create task flow bindings for the application. For example, in the home.jspx file, you will drag and drop the home.html file as your Content Presenter. By enabling a connection to the Oracle WebCenter Content repository, you will be able to manage more efficiently the content you need while optimizing the development of your application.
The other tasks described in this lesson include learning how to add a content item to the default navigation model, as well as how to take advantage of Iterative Development, which allows you to make changes to your application while it is still running on the Integrated WebLogic Server and immediately see the effects of those changes when you refresh the pages in your web browser. You will also learn how to add a new Content Query that will fetch all the documents you need in your portal application that are based on specified metadata field tags.
At the end of this lesson, the page you created in the previous lesson will look like Figure 6-1.
For more information about adding content items to the navigation model and new content queries, see "Building a Navigation Model for Your Portal" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal. For more information about managing content repositories and UCM, see Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.
This lesson contains the following steps:
Before you begin the steps in this lesson, ensure you have followed the steps up to this point in the Tutorial.
Oracle JDeveloper enables you to manage and handle document content stored on the Oracle WebCenter Portal's Content Service for Oracle WebCenter Content by creating a connection to the content repository, in this case to Oracle WebCenter Content. This connection is then owned and deployed by your portal application. You create this connection in Application Resources, as described in the following steps.
To connect to the content repository:
Connections folder. UCM. Ensure that you enter UCM in all caps. Note that you should not use any other designation for the Oracle WebCenter Content connection, like myUCM, for example. The Oracle WebCenter Content content for the Tutorial relies on this specific connection name. Ensure that the connection name is UCM. Oracle Content Server. Ensure that you check Set as primary connection for Documents service. | See Also: For detailed information, see the section, "Configuring Oracle WebCenter Content Server Repositories," in particular, "Configuration Prerequisites" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal |
weblogic and in the Password field, enter weblogic1. Expand the Connections folder.
Contributions folder and navigate to the UCM Content folder, where your uploaded content is stored. (This was set up in "Step 6: Download the Sample Tutorial Files".) Now open the Home folder with the home.html file shown in Figure 6-4. pages folder. Open the home.jspx file, then view it in Source view by clicking the Source tab. The home.jspx file appears in Source view, as shown in Figure 6-5. <cust:panelCustomizable id="hmpnc1" layout="scroll"/> at the center of the file, as shown in Figure 6-6. You will add another line of code after the selected snippet. UCM Content folder, open the Home folder and select the home.html file, shown in Figure 6-7. home.jspx file. Select the XML code snippet <cust:panelCustomizable id="hmpnc1" layout="scroll"/> shown in Figure 6-6, and drag and drop the home.html from the connection on to the panelCustomizable. It's important to understand that in the last two steps, you have added a Content Presenter task flow and set the task flow parameters to read the values from the navigation link parameters. When you run your portal application, the Home node will automatically appear in the navigation menu because the home.jspx file has already been added to the page hierarchy and the page hierarchy has been added to the default navigation model.
The new Home link appears in the navigation, with the text for document content at the center of the Home page, as shown in Figure 6-10.
In this sequence of steps, you have learned how you can take advantage of the Content Presenter task flow in order to display and render documents under a UCM Content folder as a tab.
Using the Content Presenter task flow, you are able to drag and drop a task flow onto a panel component as a region in the XML code for purposes of binding the task flow to that region. You can then set task flow parameters to read the values from the navigation link parameters.
Up to this point, you have created and built a page that can be used as a template, if you choose, onto which you can add multiple navigational links.
Now that you have successfully created a connection to the Oracle WebCenter Content repository for your WebCenter Portal application and performed the necessary steps to drag and drop the home.html file as your Content Presenter, we will create a user in the portal application who will have privileges to edit the content stored in your repository.
There are two steps involved to accomplish this particular task:
contentadmin) in the application contentadmin) in the Embedded LDAP WebLogic Server and add that user as a part of the Administrators group When you run the application after completing these steps and log in as contentadmin, the identity of this user is propagated to the Embedded LDAP of Oracle WebLogic Server.
Since the UCM instance uses the same Embedded LDAP as an identity store, and since all the users who are a part of the Administrators users group have by default Read, Write, Delete and Administration privileges, the user you've added -- contentadmin -- will be able to edit content.
To create a user in the portal application with privileges to edit content stored in your repository:
META-INF folder and open the jazn-data.xml file, shown in Figure 6-11. contentadmin in your portal application (Figure 6-12). Once you have created a user in the application, you will create a user on the embedded LDAP of Oracle WebLogic Server.
weblogic as the user name and the password you used when installing the product (Figure 6-13). myrealm name in the Realms table (Figure 6-15) and click it. contentadmin when asked what you would like to name your new user (Figure 6-18). Specify this new user as a Content Administrator when asked how you would like to describe this new user. Figure 6-21 Administrators in Available Parent Groups Added to Groups

Once you've completed these steps, the user you've added -- contentadmin -- will now be able to edit the UCM content in the content repository.
In this next sequence of steps, we move ahead to add a content item to the default navigation model XML file for the application.
To add a content item to the default navigation model:
/oracle/webcenter/portalapp/navigations). Right-click default-navigation-model.xml, and choose Open. default-navigation-model.xml file appears with a link specified as contentItem and with the Id specified also as contentItem. You will need to change these entries, as shown in Figure 6-23. Note that the Type field is set as Content. aboutus. In the URL Attributes pane, enter the Display Value as About Us. UCM Content folder and select the aboutus.html file shown in Figure 6-24. Note that you can also simply drag and drop the file from the content connection into the navigation and it will create the content item for you.
The Iterative Development option is enabled by default in your WebCenter Portal application. There are several advantages to this option.
For one thing, iterative development lets you speed up your development process by allowing you to make changes to your application while it is still running on the Integrated WebLogic Server and then immediately see the effects of those changes when you refresh the current pages in your web browser.
| Tip: On a browser refresh, you will see changes almost instantly to page definitions and page hierarchy, existing JSPX files and the navigation model, page templates, the resource catalog and task flows or portlets you may have added to pages. For example, you can add a task flow to a page and simply refresh the browser or you can change the values in task flows and right away see the results. Other operations are not supported by iterative development, however, and require you to re-run the application if you create any new file explicitly (for example, a new page definition or page hierarchy), or implicitly. For instance, when you add a sub-page to a node in the page hierarchy, a new Basically, iterative development works by disabling certain optimization features. Note that iterative development only applies when running from JDeveloper using the built-in server. This option has no effect once your portal application is deployed to a staging or production server. |
In the previous step Step 3: Add a Content Item to the Navigation Model, you added a new content link to your application, which appeared in the navigation hierarchy when you refreshed the contents of your web browser.
With Iterative Development enabled in your application, you will add a new link in JDeveloper of type Content in the default navigation model under Root, and then choose the menu.html document for that link. As you save the changes to your application and refresh the browser page, you will see the Menu node on the navigation menu. Clicking it will enable you to see the content of the Menu.
To add a new link in the default navigation model in your application:
default-navigation-model.xml file. Right-click the Application Properties menu item. default-navigation-model.xml file selected, click the plus icon to add a Content Item in the navigation, as shown in Figure 6-26. contentItem appears as a node in the default-navigation-model.xml navigation and in the Id field as contentItem. Change the Id to menu and the Display Value to Menu, as shown in Figure 6-27. Menu folder in your UCM connection and select the menu.html file, as shown in Figure 6-28. In this next step, you will add a new content query to your portal application. This query will fetch all the documents that are based on metadata field tags in the Oracle WebCenter Content repository.
To add a new content query:
default-navigation-model.xml file. menucontent. In the Content Query Attributes pane, enter as the Display Value Menu Content (Figure 6-31). Enter the Content Query text in the Query field:
Note that documents have to be tagged with the keyword menu for the content query to work properly.
| Tip: You need to perform this step, which is necessary and required in this case, to ensure that the result of the menu content query is published under the menu node because the menu content query is a child of the menu node. The step is not required in all use cases, however. |
As shown in Step 8, the Content Management Interoperability Services (CMIS) query looks like this:
SELECT cmis:name FROM ora:t:IDC:GlobalProfile WHERE ora:p:xWCTags LIKE 'menu%'
Note that UCM relies on the concept of a “display” name and an “internal” name for each metadata field. For example, in this CMIS query xWCtags is the internal name for the metadata field while Tags is the display name for the same field. When you build a CMIS query, you need to use the UCM internal name for the field.
| Tip: The CMIS query used in this example fetches all the documents based on the metadata field Keep in mind that the For more information on how to view content metadata -- in particular, the For more information on how to update content metadata, see Oracle Fusion Middleware User's Guide for Content Server. |
The following steps will enable you to set the correct values on the Tags field.
Menu folder in the Contribution Folders directory in the UCM repository, as shown in Figure 6-35. fastfood.htmlfile, shown in Figure 6-36. This action takes you to the Content Information page in Oracle Content Server (Figure 6-37). fastfood.html page (Figure 6-38). menu in the Tags field, as shown in Figure 6-38. salad.html and pasta.html, which reside in the Menu folder in your repository. Once you set the metadata on the Tags field for all the HTML files, the results of each CMIS query will appear under the Menu node when you refresh your web browser. In this lesson, you've learned the importance of working with and managing your document contents in the Oracle WebCenter Content repository. In so doing, you can optimize your development efforts, enable Iterative Development and add new content to your navigation model. You can also take advantage of adding content queries to your navigation model, which enable you to query and fetch documents based on specific metadata tags that are used in Oracle WebCenter Content.
In the next lesson, you will move ahead to extend your portal development skills by learning how to customize portal pages and add them to your page hierarchy, setting permissions on user access. In addition, you'll learn how you can easily edit HTML content in-context at runtime in your portal application.
In this lesson, as a developer at design time, you will customize the content on a specific page in the page hierarchy of your WebCenter Portal: Framework application, adding that page and its content to the hierarchy so you can set permissions for user access and editing, or modification of document content.
You will also drag and drop documents in HTML format from your UCM repository on to a consignable panel component in a new.jspx page and render that page as a Content Presenter task flow. The Content Presenter task flow lets you add content to your portal application, in this case, using the Documents service to display that document content stored in your content repository. The Documents service provides a user-friendly interface to manage, display, and search documents at runtime.
In the last step, you will enable authenticated users to edit the content of those HTML pages in-context at runtime. A pop-up window will open an editing session for adding or modifying content stored in your UCM repository.
At the end of this lesson, the home page you created in the previous lesson will look like Figure 7-1 when in-context editing of HTML content is enabled on the Contact Us page at runtime.
This lesson contains the following steps:
Before you begin the steps in this lesson, ensure you have followed the steps up to this point in the Tutorial.
Building on the steps of the previous lesson (Chapter 6), we can now move ahead to customize specific pages in our WebCenter Portal application, thus setting page permissions and user access.
To accomplish this task, we first need to create a new.jspx page, in this case, contacts.jspx, and then add that page to the Page Hierarchy. By adding the page to the hierarchy, we can set page permissions, and in so doing, we can specify user access to those pages for security purposes.
To customize pages and set page permissions in our portal application:
pages folder in Application Navigator. contacts.jspx in the File Name field and ensure that the checkbox Create as XML Document (*.jspx) is checked. contacts.jspx and open it in Source view (Figure 7-3). home.jspx file, which resides in the pages folder, open it in Source view and select the code line, which specifies the value attribute, shown in Figure 7-4. Note that this is needed so the page picks up the template changes that occur at runtime. value attribute that specifies the page template bindings, and paste this code line into the contacts.jspx file where the value attribute is located, as shown in Figure 7-5. home.jspx file, right-click the file, and choose the Go to Page Definition menu item, shown in Figure 7-6. This opens the homePageDef.xml file. homePageDef.xml file in Source view, select and copy the code snippet specifying the viewID attribute for the page template and the id for the page template binding, as shown in Figure 7-7 and in Example 7-1. contacts.jspx file, right-click the file, and choose the Go to Page Definition menu item, as shown in Figure 7-6, when you opened the homePageDef.xml file. contactsPageDef.xml file in Source view and paste the code snippet you copied from the previous step, replacing the code lines shown in Figure 7-8. These code lines specify the path and id attributes for the contacts page definition file. contacts.jspx file and open it in Source view. Then in JDeveloper, navigate to the Component Palette (choose View->Component Palette), which resides in the right-hand column of the application, and select Composer. Page Customizable component and drag and drop that component on to the contacts.jspx file after the code line <f:facet name="content">, as shown in Figure 7-9. contactus.html file on to the panelCustomizable component. datasource field. pagehierarchy folder. Now open the pages.xml file, shown in Figure 7-13. pages.xml Page Hierarchy pane opens, drag and drop the contacts.jspx file into the Root node (Figure 7-14). contacts in the Root node and in the Page Hierarchy pane, uncheck the Visible checkbox, which is shown as checked in Figure 7-14. default-navigation-model.xml file in the navigations folder and open it in Design view, as shown in Figure 7-15. pages folder, select the contacts.jspx file and drag it to the default-navigation-model node (Figure 7-16), contacts entered in the Id field. In the URL Attributes pane, enter the Display Value as Contact Us. The application opens in a web browser with Contact Us as part of the navigation model, as shown in Figure 7-18. The page is populated with the content from Composer.
For more information about creating and adding Content Presenter task flows and display templates, see the chapter "Creating Content Presenter Display Templates" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
Now that we have customized our Contacts Page in our application, dragging and dropping the contacts.html document from our UCM repository on to the panelCustomizable component in contacts.jspx and rendering it as a Content Presenter task flow, we can move on to the task of enabling in-context HTML editing capability to our documents.
In-context document editing offers authenticated users easier access and control over document content. This feature is only available at runtime, however.
weblogic (which enables you to have administrative privileges) with weblogic1 as your password (Figure 7-19), and navigate to the Contact Us page by clicking in Contact Us link in the banner. CTRL + SHIFT + C on your keyboard. The Contact Us page in the web browser appears at the center with a hash-marked outline and an edit icon below the navigation bar in the upper right corner, indicating that the outlined portion of the Contact Us page can be edited for document content, as shown in Figure 7-20. | Tip: By entering the Note that editing or customizing pages requires using a different set of tools and procedures, which enable you to add taskflows and portlets, for example, or to otherwise modify the page itself, and not just the document content on the page at runtime. |
contactus.html page and edit that content using a rich text editor, as shown in Figure 7-22. Note that the document content is stored in the UCM content repository for easy access and retrieval. In this lesson, you have learned how to customize specific pages in the page hierarchy of your WebCenter Portal: Framework application and how to add those pages to the hierarchy so you can set permissions for user access. You have also learned how easy it is to enable runtime HTML editing of your document content stored in the UCM repository by adding new content to the page and making it editable at runtime.
Congratulations! You have created a WebCenter Portal: Framework application and learned about the fundamentals of Oracle WebCenter Portal: Framework.
In this Tutorial, you learned how to perform a few quick and easy steps to create a WebCenter Portal: Framework application. You also learned how to modify and customize your application to meet the specific needs of end users coming to your web portal.
Specifically, you learned how to:
Globe to swooshy. You should now have a basic working knowledge of the fundamentals of Oracle WebCenter Portal Framework.
You can learn more about designing your own WebCenter Portal: Framework applications, including using Composer, WebCenter Services, and portlets, in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
To learn more about what you can do at runtime, including using Composer to customize pages, and how the various components behave and can be configured at runtime, see the Oracle Fusion Middleware User's Guide for Oracle WebCenter Portal: Spaces.
You can find all Oracle WebCenter Portal documentation on the WebCenter Documentation page on the Oracle Technology Network, at http://www.oracle.com/technology/products/webcenter/documentation.html.
You can learn more about other features of Oracle WebCenter Portal, and view demonstrations and see examples of WebCenter Portal: Framework applications, portlets, and services in action on the Oracle WebCenter Portal home page on the Oracle Technology Network at:
http://www.oracle.com/technology/products/webcenter/index.html.
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